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Abstract

The microdensitometry of wood, that is the quantification of density in the micrometre scale, is
important for different scientific disciplines such as wood science, dendrochronology,
dendroecology, dendroclimatology, and biomass determination and in the industrial

applications of engineered wood. With the advent of industrial computed tomography
scanners, powerful equipment for density measurement is available. However, the

methodological framework for wood density determination with those machines is not fully

established, because possible error sources have not so far been analysed and described

sufficiently. Thus, the objective of this study was the development of a methodology, in order
to quantify wood density with an industrial computed tomography scanner.

In this study, industrial cone-beam computed tomography was used for the microdensitometry
of wood. Fifty stacks of stem discs from an equal number of Pinus radiata trees were used as

the sample dataset. Firstly, the fifty stacks were scanned along with selected reference
materials, which were measured for density in a conventional way. Then, fifty linear

regressions were performed between the conventionally-determined density and the grey
value of the reference materials. A strong correlation (mean R2=0.998) between

conventionally-determined density and grey value was observed. The regressions also

provided calibration equations, which could translate a given grey value to a certain density.
For validation purposes, the fifty calibration equations were tested on extra reference

materials. The density from the computed tomography scanner had a mean absolute error of
0.008 g/cm3 (σ=0.004) and a mean percent error of 1.4% (σ=0.7). Additionally, one of the

calibration equations was applied to the creation of tree ring density profiles. An important
result of the study was that it was not possible to deduce a sole calibration equation, as

typically done with densitometers and medical computed tomography scanners. Thus, the
calibration of each scan was inevitable, due to the various degrees of freedom of the
industrial computed tomography scanner.
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Opsomming

Die mikrodensitometrie van hout, dws die kwantifisering van die digtheid op die mikrometer
skaal is belangrik vir verskillende wetenskaplike dissiplines soos houtwetenskap, dendro-

chronologie, dendro-ekologie, dendro-klimatologie, biomassa bepaling en vir die industriële
gebruik van verwerkte hout. Met die koms van die industriële tomografie skandeerders is

kragtige toerusting vir die meting van houtdigtheid beskikbaar. Die metodologiese raamwerk

vir die bepaling van hout digtheid met die masjiene is egter nog nie ten volle ontwikkel nie. Dit
kan aanleiding gee tot metingsfoute wat nie voldoende geanaliseer en beskryf word nie. Die

doel van hierdie studie is dus om ‘n metode te ontwikkel om houtdigtheid te kwantifiseer deur
die gebruik van ‘n industriële tomografie-skandeerder.

In hierdie studie is industriële laser ligstraal tomografie gebruik om die mikrodensitometrie

van hout te bepaal. Vir die monster datastel is vyftig stapels van die stam skywe van 'n gelyke
aantal Pinus radiata bome gebruik. Eerstens is die vyftig stapels geskandeer saam met

geselekteerde verwysingsmateriaal wat vir digtheid gemeet is op 'n konvensionele manier.
Daarna is vyftig lineêre regressies ontwikkel tussen die digtheid wat bepaal is deur die

konvensionele digtheidsmetode en die grys waarde van die verwysing materiaal. Met die

studie is waargeneem dat daar ‘n sterk korrelasie (R² = 0.998) is tussen die digtheid gemeet
deur die gebruik van die konvensionele metode en die gryswaarde. Die regressies voorsien

ook kalibrasie vergelykings, wat 'n gegewe grys waarde kan assosieer met 'n sekere digtheid.
Vir validerings doeleindes, is die vyftig kalibrasie vergelykings getoets op ekstra

verwysingsmateriaal. Die digtheid gemeet deur die tomografie-skandeerder het 'n gemiddelde
absolute afwyking van 0.008 g/cm³ (σ=0.004) en 'n gemiddelde 1.4% (σ=0.7) fout getoon.
Verder is een van die ontwikkelde kalibrasie vergelykings toegepas om boomring

digtheidsprofiele te skep. Die studie het bevind dat ‘n enkele kallibrasie vergelyking nie

gebruik kan word soos tipies met die gebruik van densitometers en mediese tomografie

skandeerders nie. Die industriële tomografie-skandeerder moes dus gekalibreer word met

elke skandering as gevolg van die verskillende grade van vryheid wat bevind is in die studie.
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Σύνοψη

Η μικροπυκνομετρία του ξύλου, δηλαδή η ποσοτικοποίηση της πυκνότητας στην κλίμακα του

μικρομέτρου, είναι σημαντική για διάφορα επιστημονικά πεδία όπως η επιστήμη του ξύλου, η

δενδροχρονολογία, η δενδροοικολογία, η δενδροκλιματολογία, και ο καθορισμός της βιομάζας
και σε βιομηχανικές εφαρμογές επεξεργασμένου ξύλου. Με την άφιξη των βιομηχανικών
υπολογιστικών τομογράφων, ισχυρός εξοπλισμός για τη μέτρηση της πυκνότητας είναι

διαθέσιμος. Παρ’ όλα αυτά, το μεθοδολογικό πλαίσιο για τον καθορισμό της πυκνότητας του
ξύλου με αυτά τα μηχανήματα δεν είναι πλήρως εδραιωμένο, επειδή πιθανές πηγές

σφάλματος δεν έχουν μέχρι στιγμής αναλυθεί και περιγραφεί επαρκώς. Συνεπώς, το

αντικείμενο αυτής της μελέτης ήταν η ανάπτυξη μιας μεθοδολογίας, ώστε να ποσοτικοποιηθεί
η πυκνότητα του ξύλου με ένα βιομηχανικό υπολογιστικό τομογράφο.

Σε αυτήν τη μελέτη, η βιομηχανική υπολογιστική τομογραφία κωνικής δέσμης

χρησιμοποιήθηκε για τη μικροπυκνομετρία του ξύλου. Πενήντα στοίβες δίσκων κορμών από
ένα ίσο αριθμό δέντρων Pinus radiata χρησιμοποιήθηκαν ως δείγμα δεδομένων. Αρχικά, οι

πενήντα στοίβες σκαναρίστηκαν μαζί με επιλεγμένα υλικά αναφοράς, στα οποία μετρήθηκε η

πυκνότητα με συμβατικό τρόπο. Μετά, πενήντα γραμμικές παλινδρομήσεις έγιναν μεταξύ της
συμβατικά-καθορισμένης πυκνότητας και της τιμής του γκρι των υλικών αναφοράς.

Παρατηρήθηκε μια ισχυρή συσχέτιση (μέσος όρος των R2=0.998) μεταξύ της συμβατικάκαθορισμένης πυκνότητας και της τιμής του γκρι. Οι παλινδρομήσεις επίσης παρείχαν

εξισώσεις καλιμπραρίσματος, οι οποίες μπορούσαν να μεταφράσουν μια δοθείσα τιμή του
γκρι σε μια συγκεκριμένη πυκνότητα. Για λόγους επαλήθευσης, οι πενήντα εξισώσεις
καλιμπραρίσματος δοκιμάστηκαν σε έξτρα υλικά αναφοράς. Η πυκνότητα από τον

υπολογιστικό τομογράφο είχε μέσο απόλυτο σφάλμα 0.008 g/cm3 (σ=0.004) και μέσο τοις
εκατό σφάλμα 1.4% (σ=0.7). Επιπροσθέτως, μία από τις εξισώσεις καλιμπραρίσματος

εφαρμόστηκε στην δημιουργία προφίλ πυκνότητας δακτυλίων δέντρων. Ένα σημαντικό

αποτέλεσμα της μελέτης ήταν ότι δεν ήταν δυνατόν να χρησιμοποιηθεί μια μοναδική εξίσωση
καλιμπραρίσματος, όπως τυπικά γίνεται με τους πυκνομετρητές και τους ιατρικούς

υπολογιστικούς τομογράφους. Συνεπώς, το καλιμπράρισμα του κάθε σκαναρίσματος ήταν

αναπόφευκτο, εξαιτίας των διαφόρων βαθμών ελευθερίας του βιομηχανικού υπολογιστικού
τομογράφου.
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1. Introduction
1.1.

X-ray computed tomography

1.1.1. Principle of operation

Computed tomography (CT) is a non-invasive method that provides the ability to study the
internal space of an object and to make distance, volume, and density measurements
(Kalender, 2000).

X-ray CT scanners achieve this by acquiring a series of perimetrical X-ray images of an object
(Figure 1). The value of a pixel of an X-ray image is the value of the linear attenuation

coefficient (μ) of the X-ray beam on the way through the scanned object. It can be visualized
as a grey value (gv) (Lindgren 1991a, Kalender, 2000). Then, an algorithmic process of

reconstruction (typically filtered back projection) is used for creating a three-dimensional
voxel-based volume by using the linear attenuation coefficient of the perimetrical X-ray
images (Kalender, 2000).

Figure 1 - The configuration of an industrial cone beam CT scanner

The scanned object is rotated in order to provide a series of perimetrical X-ray images. The

position of the X-ray detector and the rotator can be customized in relation to the X-ray tube.

1
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1.1.2. Linear attenuation coefficient

During a CT scan, an amount of X-ray photons will penetrate a material and the rest will
interact with it depending on the properties of the X-rays and the atoms. The significant

interaction events are the Compton scattering and the photoelectric absorption, while events
which are either insignificant or observed under extreme conditions are elastic scattering,

photodisintegration, and pair production. Therefore, the attenuation of X-ray photons by a

certain material is expressed with the linear attenuation coefficient which is the sum of the
attenuation coefficients that result from the Compton scattering and from the photoelectric
absorption (Equation 1) (Mull, 1984; Lindgren, 1991a, 1991b; Phillips & Lannutti, 1997).
=

( , )+

( , , )

Equation 1 - The total linear attenuation coefficient
: The total linear attenuation coefficient

: The attenuation coefficient that results from the Compton scattering

: The attenuation coefficient that results from the photoelectric absorption

: The density of the material
: The energy of the photon

: The effective atomic number of the material

According to Beer-Lambert law, the linear attenuation coefficient of monochromatic radiation
penetrating a chemically homogeneous material can be calculated based on the initial and

measured intensity of the X-rays and the material’s thickness (Equation 2) (Beer, 1852; Hoag,
1988; Phillips & Lannutti, 1997; Kalender, 2000; Nikolova et al., 2009, Seifert et al. 2010).
However, for a CT scanner that is used to scan an inhomogeneous material with

polychromatic radiation, the linear attenuation coefficient will be a function of energy and
position (Kalender, 2000).

2
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=

Equation 2 - The measured intensity of monochromatic radiation penetrating a homogeneous
material
: Measured intensity
: Initial intensity

: Euler’s constant (≈2.718)

: Linear attenuation coefficient
: Material thickness

1.1.3. CT numbers

Thus, a measured linear attenuation coefficient cannot be compared with a linear attenuation
coefficient from a different material, scan or scanner (Kalender, 2000). For this reason, the
medical CT scanners typically rescale the linear attenuation coefficient to normalized

radiodensity values. The radiodensity scale of CT numbers or Hounsfield Units (HU) assigns
the linear attenuation coefficient of water to 0 HU and the linear attenuation coefficient of air
to -1000 HU (Kalender, 2000; Hou et al., 2007).

1.2.

CT densitometry

The densitometry of variations in wood samples, such as tree ring cores or panels, with the
conventional method (volume divided by weight) is a time-consuming and destructive

process. In literature, fast and non-destructive wood densitometric methods beyond X-ray
imaging include:
(i)

High-frequency microscopy (Schinker et al., 2003)

(iii)

Microwave imaging (Bucur, 2003a)

(v)

Optical microscopy (Decoux et al., 2004)

(ii)

(iv)
(vi)
(vii)

(viii)
(ix)

Magnetic resonance imaging (Bucur, 2003a)
Neutron imaging (De Ridder et al., 2011)

Penetration-resistance drilling (Rinn et al., 1996; Mäkipää & Linkosalo, 2011; De

Ridder et al., 2011; Rinn, 2012)

Ultrasonic imaging (Bucur, 2003b)
β-ray imaging (Phillips, 1960)

γ-ray imaging (Laufenberg, 1986; Macedo et al., 2002)
3
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In wood densitometry, X-rays have been successfully applied with the following methods:
(i)

X-ray densitometry which is based on the 2D image of the projection of a strip of

defined thickness (typically 2 mm) (Polge, 1966, Schweingruber et al., 1978;

Cleaveland, 1983, 1986; Decoux et al., 2004; Bouriaud et al., 2005; Rathgeber et
al., 2006; Tomazello et al., 2008). While initially done on x-ray sensitive film and
analysed with an analogue densitometer, which provided greyscale values, this
(ii)

method is now typically based on digital sensors.

X-ray computed tomography which is based on the 3D reconstruction of the volume

of a wood sample from many images) (Mull, 1984; Lindgren, 1991a, 1991b;

Macedo et al., 2002; Espinoza et al., 2005; zu Castell et al., 2005; Freyburger et al.,
2009; De Ridder et al., 2011).

In 2D X-ray densitometry, the greyscale - density calibration is achieved by a step wedge,

which is typically made from a material with similar absorption characteristics as wood. In this
projection-based method, each step of the wedge gives a grey value that depends on density
and thickness. In contrast, in CT, a grey value does not depend on thickness. Thus, in CT

densitometry, an imaging phantom is used (Cook & Kairiukstis, 1990). An imaging phantom is
consisted from preferably homogenous reference materials with different density but similar

absorption characteristics with the scanned sample. Each material provides a conventionallydetermined density and an average grey value. Thus, a linear regression between the

conventionally-determined density and the grey value enables the calculation of the CT
density for any grey value of the reconstructed volume.

1.3.

Motivation

Wood density is a fundamental property because it correlates with several mechanical,

morphological, physiological, and ecological properties (Cown & Ball, 2001; Espinoza et al.,
2005; Chave et al., 2006).

In the timber industry, wood density is considered the most significant single indicator of wood
quality because it is correlated to numerous properties such as mechanical strength and

stiffness, compression, decay resistance, workability and larger yields of pulp (Cown et al.,

1991; Cown & Harris, 1991; Koubaa et al., 2002; Espinoza et al., 2005; Chave et al., 2006;
Knapic et al., 2007; Freyburger et al., 2009; Wessels et al., 2015).
4
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In the context of global change, wood density is used to estimate the woody biomass of a

forest in order to access the carbon storage of a forest source or of forest products (Chave et

al., 2006; Freyburger et al., 2009; Seifert & Seifert, 2014; Magalhães & Seifert, 2015a; 2015b;
Phiri et al., 2015).

In engineered wood products such as wood fibre, particle, flake or veneer panels, the internal
density variations determine their physical and mechanical properties like hardness, bending
strength and stiffness, porosity, internal bond strength, holding strength of nails and screws
(Laufenberg, 1986;)

In the discipline of dendrochronology, wood density is also of great importance, since it

provides additional contrast to optical tree ring measurements and additional parameters that
can be correlated with climatic influences such as the latewood density (Cleaveland, 1986;

Schweingruber & Kienast, 1986; Schweingruber, 1988; Cook & Kairiukstis, 1990; Briffa et al.,
2002). In the broader sense of the term, dendrochronology includes many subdisciplines e.g.

dendroarchaeology, dendrochemistry, dendroclimatology, dendroecology, dendroentomology,
dendrogeomorphology, dendroglaciology, dendrohydrology, dendropyrochronology and

dendroseismology (Fritts, 1976). Thus, for example, in dendroclimatology, wood density is

considered a key parameter for climate reconstruction because of its strong correlation with

climate (Hughes et al., 1984; D’Arrigo et al., 1992; Briffa et al., 1995; Briffa et al., 1998 cited in
Bouriaud, et al., 2005).

Furthermore, dendrochronology uses wood density profiles which are a series of consecutive

density measurements from the innermost to the outermost tree ring. The density profiles can
be used for ring-wise measurements (e.g. ring width, earlywood ring width, latewood ring

width, latewood width percentage, average ring density, average earlywood density, average
latewood density, ring density standard deviation) and for statistical modelling of density in

relation to ring width, growth conditions etc. (Cleaveland, 1983; Koubaa et al., 2002; Nocetti
et al., 2011).

1.4.

Identification of gaps of knowledge

The greyscale - density calibration can be influenced negatively by factors such as porosity,
atomic numbers, quantum noise, artefacts related to topography, changes in the

reconstruction algorithm, changes in the X-ray tube and the detector and aging of the X-ray

tube (Phillips & Lannutti, 1997; Stoel et al., 2008). Most of the research studies were based
5
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on medical CT scanners, which are quite limited in the ways the scan can be manipulated in
terms of spatial resolution, voltage and current and thus are known to deliver quite

homogeneous density results (Mull, 1984; Lindgren, 1991a, 1991b; Espinoza et al., 2005;

Hou et al., 2007; Freyburger et al., 2009; Nikolova et al., 2009). In contrast, modern industrial
cone beam CT scanners are fully customizable. The advent of industrial CT scanners has
brought novel ways to analyse wood in terms of spatial and density resolution. However,
there is not a standardized methodology of wood microdensitometry with industrial CT

scanners to date, which substantially inhibits the comparability of results obtained with such
machines.

6
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2. Materials and Methods
2.1.

Overall objective

To address the mentioned shortcomings, the research objective of this thesis was the

contribution to the development of a robust methodology for accurate microdensitometry of

wood samples with an industrial cone beam CT scanner. Within that context the study aimed

at developing the methodological foundation for microdensitometry of Pinus radiata in a larger
research project, so it was a logic choice to demonstrate the feasibility of the method on
selected samples of that tree species.

The main objective of this thesis was the development of an accurate and robust

methodology for the greyscale - density calibration of reconstructed volumes of wood
samples.

As an additional objective, the greyscale - density calibration was applied for the creation of
tree ring CT density profiles to show the feasibility of the method in radial density profiling.
Further analysis of the density profiles from a forest and wood science perspective was
beyond the goal of this study.

2.2.

Summary of the methodology

The methodology can be summarized as follows (Figure 2):
(i)

(ii)
(iii)

The first stage of the methodology was the fabrication of an imaging phantom from

reference materials with similar chemical composition to the wood samples. Stem
discs of Pinus radiata were regarded as the wood samples.

The second stage was the CT scanning of the wood samples including the imaging

phantom on each scan.

The third stage was the development of calibration equations that linked greyscale

and density for each reconstructed volume. This was achieved by performing a

regression between the conventionally-determined density and the grey value of
the phantom’s reference materials. Then, the calibration was validated by

calculating the error between the conventionally-determined density and the CT
density of extra reference materials.

7
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Stage 1:

Imaging phantom
fabrication

Fabrication of the imaging phantom from reference materials with
similar chemical composition to the wood samples

Stage 2:

CT scanning of the wood samples including the imaging phantom

Stage 3:

Conventional density measurement of phantom’s reference

calibration

Grey value measurement of phantom’s reference materials

CT scanning

Greyscale - density

on each scan

materials

Greyscale - density calibration equations

Validation of the greyscale - density calibration equations
Figure 2 - A synopsis of the methodology

8
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2.3.

Imaging phantom and wood samples

A first step for the fabrication of the imaging phantom (reference body serving for the

greyscale - density calibration) was the selection of materials with different densities. Thus,
fourteen slices of wood from eleven different tree species (Acacia erioloba, Celtis africana,
two samples of Eucalyptus cladocalyx, Eucalyptus gomphocephala, Eucalyptus grandis ×

Eucalyptus camaldulensis, Ochroma pyramidale, Picea abies, Pinus pinea - heartwood, Pinus

pinea - sapwood, two samples of Pinus radiata, Pinus sp., and Pinus sylvestris) and one slice

of polyoxymethylene (acetal) were cut. All the slices had a uniform thickness of 1 cm. Three
stacks were formed by sticking the slices to each other with a double-sided tape (Figure 3).
The cell wall of wood consists from cellulose (C6H10O5), hemicellulose, lignin (C9H10O2,

C10H12O3, C11H14O4) and pectin (C6H10O7) and their density is ranging around 1.5 gr/cm3

(Kellogg & Wangaard, 1969; Gibson, 2012). Acetal ((CH2O)n) is a polymer made up from the
same chemical elements (carbon, hydrogen and oxygen) and has a close density (1.41-1.42

gr/cm3) to the cell wall. Thus, it was hypothesized that it could be used optionally as an extra
reference material.

One of the objectives of this study was to show the feasibility of the greyscale - density

calibration for reconstructed volumes of wood samples. Thus, fifty stacks of Pinus radiata

stem discs from an earlier study (Fischer, 2011), which were cut from an equal number of
trees, were selected as the wood samples (Figure 4). The trees were at half rotation age,

between nine and eighteen years old. Furthermore, five discs were cut from each tree. The

first disc was cut at base height (0.1 m), the second disc was cut at breast height (1.3 m) and
the third disc was cut at the beginning of the canopy. The fourth and the fifth disc were cut at
one third and two thirds of the canopy’s length respectively.

The minimum, maximum and average diameter was calculated for the discs of each height,
without including the bark (Table 1).

The stems disks and some of imaging phantom materials were air-dried for at least a year.
Their moisture content was measured on samples before scanning. However, there was a
flooding incident at the workshop, which added moisture to the stem disks.

The stems disks were air-dried for at least a year and their moisture content was measured

on samples and found to be 12%. The imaging phantom materials were oven-dried at 60°C

and left to reach the same moisture equilibrium.
9
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Figure 3 - The imaging phantom

Figure 4 - A part of the Pinus radiata stacks which were used for testing the method
10
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Table 1 - The minimum, maximum and average diameter of the discs of each height
Discs from

Diameter (cm)
Minimum Maximum Average
Height 1 (0.1m)
14.6
28.7
22.4
Height 2 (1.3m)
12.7
27.9
20.0
Height 3 (Beginning of canopy)
11.3
26.5
17.8
Height 4 (Beginning of canopy + 1/3 of canopy’s length)
6.9
20.3
13.2
Height 5 (Beginning of canopy + 2/3 of canopy’s length)
3.4
13.3
7.7

2.4.

CT scanning procedure

The P. radiata stacks were scanned in a General Electric Phoenix VTomeX L240 CT scanner
with the following scheme:

(i) Each P. radiata stack was scanned separately and the three phantom stacks were

included in every scan. The position of the phantom stacks was wherever there was
available space and thus was variable. All the objects were placed onto packaging

foam which was placed onto the rotating metallic chuck of the CT scanner in order to

prevent artefacts from metal and X-ray interaction. All the objects were stuck together
by poster putty in order to prevent movement during their rotation. Furthermore, all
stacks were scanned in four continuous days with equal hot and dry climate.

Additionally, the air conditioner was used in the CT scanner room to prevent moisture
and temperature fluctuations.

(ii) The spatial resolution (volume represented by a voxel) was increased to the point that

the largest P. radiata stack could exactly fit in the acquired X-ray images. The resulting
position of the X-ray detector and the rotating chuck were kept constant for all the
scans to avoid any fluctuations to the measured grey value of the X-ray images.

(iii) Before placing any objects inside the scanner and starting a new scan, the X-ray

detector was auto-calibrated to the signal of the X-rays. This digital procedure ensures
that the detector receives an even X-ray signal. After the auto-calibration, the CT
scanner was left to stabilize for 10 minutes.

(iv) Upfront, the voltage and the amperage were adjusted empirically by experimentation to
deliver the best images. Specifically, a stem disc stack was scanned with various

combinations of voltage and amperage. The combination of 200 kV and 200 μA was
11
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selected because it provided the ideal brightness and contrast on the reconstruction of
the disc stack. All further disc stacks were scanned with these parameters.

(v) Furthermore, a copper (Cu) (1mm) filter and an aluminium (Al) (1mm) filter were
tested, but none was used for the scans because they affected the contrast.

(vi) The following parameters were set as shown on Table 2:

Table 2 - The settings of the scans

Parameter
Voltage
Amperage
Image resolution
Perimetrical images
Image binning
Images acquired/skipped
Image exposure time
Scan duration
Region of Interest (ROI)

Value
200 kV
200 μA
2048×2048
3000
No
1 acquired/1skipped
333ms
36′
Yes

After the scans, the ‘General Electric Phoenix DatosX’ software created the reconstructed
volumes of the scanned objects. Beam hardening correction was included in the

reconstruction to avoid beam hardening effects which are substantial if objects of different
size and density are scanned. The effect is based on the fact that the X-ray tube does not

emit a monochromatic radiation beam but it emits a beam of X-rays with a wider distribution of
frequencies and with different penetration ability. Harder X-rays will penetrate longer
distances while softer X-rays will penetrate less easily. This phenomenon leads to a

hardening of the beam with increasing distance through the object. This means that the beam
penetration is higher at the end of the penetration through the object. Thus, an internal

procedure during the reconstruction process is applied to compensate for such effects.

Examples of image acquisition from a CT scan and of a reconstructed volume can be seen on
Figure 5, 6, and 7.
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Figure 5 - An X-ray image from a CT scan

This image is one of the 3000 perimetrical X-ray images of a scan from which a volume was
reconstructed. It includes the five P. radiata stem discs and the imaging phantom.

Darker pixels denote reduced X-ray penetration and thus increased linear attenuation
coefficient.
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Imaging phantom

P. radiata stem discs

Figure 6 - A reconstructed volume

The reconstructed volume includes five stem discs from a P. radiata tree and the imaging
phantom.
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Figure 7 - A cross-section of a reconstructed volume

Brighter pixels represent higher densities and darker pixels, lower densities.
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2.5.

Greyscale - density calibration

Conventional density measurement of the phantom slices

In order to determine the density of the slices conventionally, their volume was measured with
a digital calliper and their weight with a digital scale.
Grey value measurement of the phantom slices

A batch of cross-sectional ‘tiff’ images with spacing of 1mm was exported from every

reconstructed volume with the help of ‘VGStudio MAX’ and then it was imported into the

‘ImageJ’ software (File → Import → Image Sequence) (Figure 8). On ‘ImageJ’, the cross-

sectional images were also calibrated for distance measurements (Image → Properties) by

using the spatial resolution provided by ‘VGStudio MAX’, e.g. 0.14939 mm/voxel. This was

necessary because the spatial resolution information was not imported into the images and

had to be added manually. Additionally, the images were coloured with pseudocolour in order

to make it easier to distinguish between earlywood and latewood (Image → Lookup Tables →
Fire). Moreover, this did not affect the measurements. Finally every batch of images was
saved as one ‘tiff’ file in order to speed up the measurement process.

The average grey value of a slice was measured by locating an image where that slice was

present. Then the area of the slice was selected by applying a threshold tool (Toolset→ Wand
tool) and after that by measuring the average grey value of the pixels of the selected area

(Analyze → Measure). The average grey value was taken from only one image in order to
speed up the measurement process.

16
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Figure 8 - A cross-sectional image with pseudocolour

A P. radiata stem disk and three phantom slices are visible.

The values of the pixels increase from 0 to 255 in response to density.
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Greyscale - density calibration equations

A traditional least squares regression minimizes the squares only in the direction of the y-axis.
This is correct if measurement errors are present only on the y-axis direction. If there are

measurement errors also on the x-axis variable then the traditional least squares regression

produces biased results. In our case we can assume that the grey values are also measured

with a certain error. Thus the linear reduced major axis (RMA) regression was chosen, which
adjusts the fitted line accordingly to prevent a bias (Warton et al. 2006; Seifert et al., 2010).
With the help of the programing language R, a RMA regression was performed for each

reconstructed volume between the conventionally-determined density of the slices and the

grey value of the slices, in order to obtain a calibration equation (Appendix A). A calibration

equation is a volume-specific linear equation, which translates a given grey value to a certain
CT density (Equation 3).

=

·

+

Equation 3 - Translation of a grey value into CT density
: CT density

: Grey value

Validation of the greyscale - density calibration equations

The CT density and the CT density error (absolute and percent) of the three validation slices

were calculated for each reconstructed volume (Equation 4 and 5). Then, the mean absolute
error and the mean percent error of the three validation slices were calculated for each
volume and plotted in two histograms.
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= |

−

|

Equation 4 - The absolute error of the CT density of a phantom slice
: Absolute error

: Conventionally-determined density
: CT density

=

−

∗ 100

Equation 5 - The percent error of the CT density of a phantom slice
: Percent error

: Conventionally-determined density
: CT density
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2.6.

Tree ring CT density profile

The CT density measurement was demonstrated by constructing the tree ring CT density
profile of five stem discs from the same tree.

For each cross-sectional image, a rectangular strip starting from the end of the pith and

ending at the end of the outermost ring was drawn (Figure 9). The width of the strip was

specified to be 25 pixels by using the ‘Specify’ function (Edit → Selection → Specify). Then,

the ‘Plot Profile’ tool (Analyze → Plot Profile) was used to create a table of the average grey
value along the strip.

Then, the table was copied on ‘MS Excel’ (Plot Profile → Copy) where the CT density was

calculated for each grey value by applying the volume-specific calibration equation (Table 3).
Lastly, the table of the CT density profile was plotted. The mean CT density of each profile
was also calculated.

As an optional step, the strips were copied (Edit → Copy to System), they were pasted on

their corresponding graph and then they were scaled to the same length of the graph. This
way of displaying density profiles shows the density differences in the radial direction and
their correspondence to the different years.

A strip width of one pixel (0.149 mm) would produce a CT density profile influenced strongly
by local density fluctuations since due to the high geometrical resolution the grey values of

small anatomical features such as resin ducts or even cell lumina and walls will be picked up.
In this case, a low pass filter could be applied to smooth the profile. However, a typical kernel
filtering, as applied in signal processing, would work in radial direction which represents cell

formation over time in a tree stem. A filter with a symmetric smoothing kernel would mix cells
that were formed before and after the point of interest and thus include future density values
which would be not logical. An asymmetric kernel would still include density values of cells
that were formed before the point of interest. Thus, it is better to average in a tangential

direction. Consequentially, a strip width between 10 (1.49 mm) and 25 (3.73 mm) pixels could
provide a reasonable average density, acting essentially like a low pass filter (Figure 10, 11,
and 12). Furthermore, it was found that in experiments with strips larger than 25 pixels in

width would not produce accurate average density values, because of the curvature of the
tree rings would again mix cells that were formed at different times.
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Figure 9 - CT density profile selection on Image J

Each column of pixels inside the selection has a width of 25 pixels. The ‘Plot Profile’ tool took
the average grey value from every column and its distance starting from the left.
Table 3 - Example of a CT density profile table

A part of the CT density profile table of stem disc 1. The CT density results from the
application of the volume-specific calibration equation.
Distance from pith (mm) Grey value CT density (g/m3)

0.00
0.15
0.30
0.45
…

64.00
61.72
62.68
63.08
…
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CT density (g/cm3)

1

0.8
0.6
0.4
0.2

0

0

20

40
60
80
Distance from pith (mm)

100

120

0

20

40
60
80
Distance from pith (mm)

100

120

0

20

40
60
80
Distance from pith (mm)

100

120

CT density (g/cm3)

1

0.8
0.6
0.4
0.2

0

CT density (g/cm3)

1

0.8
0.6
0.4
0.2

0

Figure 10, 11 and 12 - The effect of the strip width (1, 10, and 25 pixels) on the density profile
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2.7.

Potential sources of CT density error

2.7.1. Homogeneity of phantom slices

Due to local density fluctuations or system noise, a large deviation in the grey value of the

cross-sectional images (spacing of 1 mm) of a phantom slice could affect the regression and
therefore the calibration equation. Thus, a large deviation in the grey value could be a

potential source of CT density error. For this reason, the standard deviation of all the cross-

sectional images of each phantom slice from five reconstructed volumes was calculated (15
slices × 5 reconstructed volumes = 75 slices).
2.7.2. Number of phantom slices

Another potential source of CT density error could be the number of phantom slices used for
the regression. An inadequate number of phantom slices would affect the reliability of the
measured CT density. In order to determine the optimal number of phantom slices,

regressions with 4, 6, 8, 10, and 12 phantom slices were performed for five reconstructed
volumes (5 regressions with different number of slices × 5 reconstructed volumes = 25
regressions).
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3. Results
3.1.

Greyscale - density calibration

Conventional density measurement of the phantom slices

The conventionally-determined density of the wood slices was ranging from 0.21 g/cm3 to

1.25 g/cm3 and the conventionally-determined density of acetal was 1.43 kg/m3 (Table 4).
Table 4 - Air-dry conventionally-determined density of the phantom slices
Scientific name

Common name

Ochroma pyramidale
Pinus sp.
Pinus radiata - sample b
Pinus radiata - sample a
Picea abies
Pinus sylvestris
Celtis africana
Eucalyptus grandis × Eucalyptus
camaldulensis
Pinus pinea - sapwood
Eucalyptus cladocalyx - sample b
Pinus pinea - heartwood
Eucalyptus gomphocephala
Eucalyptus cladocalyx - sample a
Acacia erioloba
Polyoxymethylene

Balsa
Pine
Radiata Pine
Radiata Pine
Norway Spruce
Scots Pine
White Stinkwood
Rose Gum and River Red Gum
hybrid
Stone Pine
Sugar Gum
Stone Pine
Tuart
Sugar Gum
Camel Thorn
Acetal

Density
(g/cm3)
0.21
0.36
0.39
0.41
0.44
0.55
0.60
0.73

0.76
0.80
0.82
0.90
0.97
1.25
1.43

Grey value measurement of the phantom slices

Six phantom slices (Acacia erioloba, Eucalyptus gomphocephala, Ochroma pyramidale, Pinus
pinea - heartwood, Pinus sylvestris, and Polyoxymethylene) were selected for the greyscale density calibration and three (Eucalyptus cladocalyx - sample a, Picea abies, and Pinus

radiata - sample a) were selected for the validation of the calibration. Ideally, more slices
would offer greater reliability to the greyscale - density calibration (see 3.3.2 Number of
phantom slices).
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Greyscale - density calibration equations

The fifty regressions had a mean coefficient of determination R2=0.998 and p-values<0.001
(Appendix B) (Figure 13). An R2>0.99 was observed for 100% of the regressions and an

R2>0.995 for 96% of the regressions. Thus, it can be concluded that there is a strong
correlation between conventionally-determined density and grey value.

Acetal lined up visually with the wood slices and increased the coefficient of determination in
the regressions. Thus, it was concluded that acetal’s different chemical composition was
similar enough to wood and had not a significant effect on its grey value.
1.6

CT density = 0.01166322 * gv - 0.3129883
R² = 0.999

Convetional density

1.4
1.2
1.0
0.8
0.6
0.4
0.2
0.0

0

20

40

60

80
100
Grey value

Figure 13 - One of the fifty greyscale - density regressions
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As a test, the calibration equations were solved for the same grey value range (40-90) and
gave CT densities with a large dispersion (Figure 14). Thus, it was concluded that the

calibration equations varied significantly. As a consequence, a sole calibration equation could
not be derived.
1.0
0.8

CT density

0.6
0.4
0.2
0.0
-0.2

0

20

40

60
Grey value

Figure 14 - The dispersion of the calibration equations

The equations were solved for the same grey value range.
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Validation of the greyscale - density calibration equations

The absolute CT density error of the reconstructed volumes was ranging from 0.002 - 0.026
g/cm3 and had a mean of 0.008 g/cm3 (σ=0.004). Specifically, the absolute CT density error
was smaller than 0.01 g/cm3 for 74% (n=37) of the reconstructed volumes, it was ranging

between 0.01 and 0.02 g/cm3 for 24% (n=12) of the volumes and it was ranging from 0.02 to
0.03 g/cm3 for 2% (n=1) of the volumes (Figure 15).

The percent CT density error of the reconstructed volumes was ranging from 0.4% - 4.4% and
had a mean of 1.4% (σ=0.7). Specifically, the percent CT density error was smaller than 1%
for 30% (n=15) of the volumes, it was ranging between 1 and 2% for 52% (n=26) of the

volumes, it was ranging between 2 and 3% for 16% (n=8) of the volumes and it was larger
than 3% for 2% (n=1) of the volumes (Figure 16).
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100%
75%

Frequency (%) of
reconstructed
volumes

74%

50%
24%

25%
0%

2%
0.00 - 0.01

0.01 - 0.02

Absolute error (g/cm³)

0.02 - 0.03

Figure 15 - The frequency of reconstructed volumes per CT density error
100%

Frequency (%) of
reconstructed
volumes

75%
52%

50%
25%
0%

30%
16%

0-1

0%

1-2
2-3
3-4
Percent error (%)

2%
4-5

Figure 16 - The frequency of reconstructed volumes per CT density error (%)
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3.2.

Tree ring CT density profile

The density profiles showed the expected earlywood - latewood pattern with the characteristic
upward trend (Figure 17, 18, 19, 20, and 21). The density had a reasonable spread between

earlywood and latewood. The average density of each stem disc was also reasonable (Table
5). However, the outmost rings had a distinct increased density.
Table 5 - The mean CT density of each stem disc

Profile number Average CT density g/cm3
1
0.44
2
0.43
3
0.41
4
0.45
5
0.46

1.0
0.8

ρCT
(g/cm3)

0.6
0.4
0.2
0.0

0

20

40
60
80
Distance from pith (mm)

Figure 17 - The CT density profile of stem disc 1
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1.0
0.8

ρCT
(g/cm3)

0.6
0.4
0.2
0.0

0

20

40
60
80
Distance from pith (mm)

100

120

Figure 18 - The CT density profile of stem disc 2
1.0
0.8

ρCT
(g/cm3)

0.6
0.4
0.2
0.0

0

20

40
60
80
Distance from pith (mm)

Figure 19 - The CT density profile of stem disc 3
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1.0
0.8

ρCT
(g/cm3)

0.6
0.4
0.2
0.0

0
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100

120

100
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Figure 20 - The CT density profile of stem disc 4
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0.8
ρCT
(g/cm3)
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0
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80
Distance from pith (mm)

Figure 21 - The CT density profile of stem disc 5
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3.3.

Potential sources of CT density error

3.3.1. Homogeneity of phantom slices

The standard deviation in the grey value of the cross-sectional images was s<1 for 95% of the
phantom slices (71 out of 75 slices). The 100% of the slices had a standard deviation s<1.5.
Therefore, the deviation in the grey value of the cross-sectional images of a phantom slice
has a small or negligible effect on the conventional density - grey value regression.
3.3.2. Number of phantom slices

In the following graph (Figure 22), each pair of confidence intervals (95%) is the average of
five regressions from an equal number of reconstructed volumes. The colour denotes the
number of phantom slices used.

It can be observed that the more the materials, the narrower the confidence intervals. Thus, it
can be concluded that the reliability of a CT density calibration equation increases with the

number of phantom slices used in the regression. In this study, a 10 material regression is the
optimal, since a 12 material regression does not offer narrower confidence intervals.
1.20

Intervals of
12 material
regressions

Convetional density

1.00

Intervals of
10 material
regressions

0.80

Intervals of
8 material
regressions

0.60
0.40

Intervals of
6 material
regressions

0.20
0.00

40

50

60

70

Grey value

80

90

Intervals of
4 material
regressions

Figure 22 - The confidence intervals of regressions with 4, 6, 8, 10, and 12 materials
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4. Discussion
4.1.

Accuracy and repeatability of the greyscale - density calibration

4.1.1. CT density error

It can be concluded that the greyscale - density calibration was achieved with a small amount
of error and a high repeatability because:
(i)

(ii)
(iii)

The absolute CT density error of the reconstructed volumes was ranging from

0.002 - 0.026 g/cm3 with a mean of 0.008 g/cm3 (σ=0.004).

The percent CT density error of the reconstructed volumes was ranging from 0.4% -

4.4% with a mean of 1.4% (σ=0.7).

For 98% of the reconstructed volumes, the absolute CT density error was smaller

than 0.02 g/cm3 and the percent CT density error was smaller than 3% (Figure 15

and 16).

Likewise, it can be concluded that the creation of the tree ring CT density profiles (Figure 17,
18, 19, 20 and 21) was also achieved because:
(i)

(ii)

The reconstructed volume that was used for the tree ring CT density profiles had an

absolute CT density error of 0.003 g/cm3 which indicates a small amount of error in

other CT density values.

The observed air-dry CT density is consistent with the reported air-dry density of P.

radiata. The mean CT density of the profiles was ranging from 0.41 to 0.46 g/cm3

while the reported density of P. radiata was about 0.48 g/cm3 in 10 to 20 year old

trees (Forest Products Commission Western Australia, 2015).

However, the density of the outmost rings was rather high, which can be attributed to beam
hardening or to an increased content of resin in that sapwood region.
4.1.2. Homogeneity of phantom slices

The grey value of the cross-sectional images did not deviate significantly (s<1) for 95% of the
measured phantom slices (71 out of 75 slices). Thus, any inhomogeneity, due to the

earlywood and latewood pattern or due to system noise, had a small or negligible effect on
the deviation of the grey value and therefore to the greyscale - density calibration.
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4.1.3. Number of phantom slices

Six phantoms slices were used for the greyscale - density calibration and three for the

validation of the calibration. It was observed that a higher number of phantom slices increase

the reliability of the calibration equations. Therefore, greyscale - density calibrations with more
phantom slices could have possibly reduced the CT density error.
4.1.4. Chemical composition of phantom slices

The measured grey value of a phantom slice is defined among others by its chemical

composition. For this reason, the chemical composition of the materials of a phantom should
be similar to the objects of interest (Phillips & Lannutti, 1997; Stoel et al., 2008). The

difference in density between species is not an effect of different chemical composition but it
depends on the proportion of the cell wall material and air in dry wood. Thus, air-dry wood
density can range from very light wood such as Ochroma pyramidale (150 kg/m3) to very

dense wood such as Guaiacum officinale (1300 kg/m3). The cell wall consists from cellulose

(C6H10O5), hemicellulose, lignin (C9H10O2, C10H12O3, C11H14O4) and pectin (C6H10O7) and their

density is ranging around 1.5 gr/cm3 (Kellogg & Wangaard, 1969; Gibson, 2012).

Wood, as a porous material, also contains air (N2, O2, Ar and CO2) (0.001225 g/cm3) and

water (H2O) (1 g/cm3). Thus, it is critical for precise CT density measurements to dry the

imaging phantom and the examined wood samples to constant moisture content (Cleaveland,
1983). Phiri (2013) showed how differences in drying temperature can affect the equilibrium
weight of Eucalyptus. In X-ray densitometry, the air-dried density (around 12%) is common
(Bouriaud et al., 2005; Taylor, 2006; Tomazello et al., 2008; Freyburger et al., 2009; De
Ridder et al., 2011). The moisture content of the stem discs and the imaging phantom

materials was not measured again after the scans. Thus, the CT density error can possibly be
partially attributed to the control of the moisture content.

Furthermore, wood contain various extractives which are organic and inorganic, non-

structural materials that contribute to density substantially, especially in heartwood (Cown &
Harris, 1991). In particular, conifers are known to have high resin contents and can

additionally form pitch pockets (Seifert et al. 2010b). In order for the scanned materials to

have similar chemical composition, resins can be removed by alcohol (Zamudio et al., 2002)
or an alcohol-benzene solution (Cleaveland, 1983). It is possible that such differences in

chemical composition can also be considered partially responsible for the CT density error. In
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this point, the densities of CT-scanned samples are not comparable with results from 2D Xray densitometry, where typically the extractives are extracted before X-ray exposure.

Regarding acetal ((CH2O)n), it can be concluded that its different chemical composition had

not a significant effect on its grey value, since it lined up visually with the other materials and
it increased the coefficient of determination of the regressions. This was expected since

acetal is traditionally used as a homogeneous calibration material for 2D X-ray densitometry
(e.g. Hoag 1988)

4.1.5. Stability of the calibrations

In studies with medical CT scanners, a single calibration equation is reported to be sufficient,
provided the scanner settings are kept the same (Lindgren, 1991a; Taylor, 2006; Freyburger

et al., 2009). In contrast, in this study, each reconstructed volume needed a specific greyscale
- density calibration equation. This can be attributed to the automatic assignment of the grey
values (grey value scaling) by the CT scanner, with black voxels representing air as the

material with the lowest density in the scan and white voxels representing poster putty as the
material with the highest density in the scan. Specifically, it could be observed by visual

inspection of the images that some volumes were brighter or darker than others. Therefore,

the shift of the grey values from volume to volume contributed to differences of the calibration
equations.

It has to be noted, though, that the shift of the grey values did not affect the CT density error.

Specifically, in seven volumes, the whitest voxels belonged to (metallic) staples. Although, the
assignment of the grey values was different, the CT density error of these volumes was about
the same with the rest.

To sum up these results, it can be stated that it is necessary to scan calibration phantoms
with every scan, if a plausible and comparable density should be determined.

4.2.

Spatial accuracy

A higher spatial resolution increases the structural detail of a reconstructed object. A higher

resolution can be achieved by reducing the distance between the X-ray tube and the object so
that and the projection on the detector is covered by more detector elements. Thus, it was

attempted to minimize this distance as much as possible. The distance that was chosen as

optimal was the distance that the projection of the larger stack of stem discs was marginally
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fitting on the X-ray detector. This distance resulted in a spatial resolution of approximately 150
μm/voxel or 6.7 voxels/mm when scanning a stack of discs.

In comparison with a similar study, De Ridder et al., (2011) scanned wood cores with a spatial
resolution of 50 μm/voxel. In X-ray radiography, the spatial resolution (digitized X-ray film
negatives) is larger and each ring can be divided in 100 segments in order to provide an

equal number of density values (Cleaveland, 1983; Bouriaud et al., 2005; Rathgeber et al.,

2006). However the obtainable resolution is clearly determined by sample size which in this

study was considerably larger than in the other mentioned studies so that a trade-off between
sample size and spatial resolution was evident.

4.3.

Outlook on future work

The requirement for accurately-determined CT density and the requirement for comparison of
results from different studies that involve CT densitometry lead inevitably to the

standardization of the CT densitometry of wood. Thus, future work that targets this
standardization could focus on:
i)

The fabrication and use of homogeneous phantom compartments from cellulose of

different packing. An alternative to solid wood phantoms can be the use of wood

pulp phantoms from wood pulp of various densities. This is similar to the calibration
wedges from wood pulp that have been used in X-ray radiography (Cleaveland,

1983). Furthermore, if the chemical composition of a wood pulp phantom was to be
known, then the density could be calculated in principle and it could be used as a
ii)

prediction for the CT density.

The automatic volume-based grey value measurement of phantom slices in order to
increase the accuracy and repeatability of the grey value measurement process.
Additionally, the automatic measurement could decrease the required time for

measuring a phantom slice and thus it could process a larger number of phantoms

slices which would increase the accuracy of the calibration and the accuracy of the
validation. The automatic measurement possible through the fabrication of the
iii)

proper phantom and the use of the proper software (Stoel et al., 2008).

The effect of various factors such as voltage, amperage and effective atomic

number on the greyscale - density calibration.
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iv)
v)

The simultaneous scan of imaging phantom and wood samples and its effect on the

greyscale - density calibration due to artefacts such as beam hardening.

The further investigation of the stability of the calibration procedure with perspective

the derivation of a single calibration equation.

With these proposed future improvements, X-ray based microdensitometry could enfold its full
potential with regards to the application in wood and forest science.
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5. Conclusions

It was successfully demonstrated that an industrial cone-beam CT scanner can be used for
wood microdensitometry and, furthermore, for the creation of tree ring CT density profiles.

The absolute CT density error of the reconstructed volumes was ranging from 0.002 - 0.026

g/cm3 with a mean of 0.008 g/cm3 (σ=0.004) (Figure 15). The percent CT density error of the
reconstructed volumes was ranging from 0.4% - 4.4% with a mean of 1.4% (σ=0.7) (Figure
16).

The CT density error can possibly be attributed to:
(i)

(ii)

The small number of phantom slices. Specifically, six phantoms slices were used

for the greyscale - density calibration and three for the validation of the calibration.
Differences in the chemical composition of the phantom slices and the wood

samples. These are the moisture content, resins and various other extractives.

The CT density error cannot be attributed to the inhomogeneity of wood.

Acetal can be used as an extra reference material in the imaging phantom, since its different
chemical composition in relation to wood does not affect its grey value.

Lastly, it is necessary to scan calibration phantoms with every scan, in order to achieve a
plausible and comparable density.
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Appendix A. Regression example

The regression dataset was saved as an ‘xlsx’ file (Table 6). The first column has the

conventionally-determined density of the phantom slices and the second column has the grey
value of the phantom slices of a reconstructed volume.
Table 6 - Example of a regression dataset

Convetional_density gv_volume1
0.209
44.99155
0.407
59.32669
0.546
70.9091
0.82
92.31391
0.901
98.98724
1.248
124.36734

# The following code was written in R. It requires the packages lmodel2 and Rcmdr.
# Load the required packages
library(lmodel2)
library(Rcmdr)
#Go to R commander, click on “Data->Import data->from Excel, Access, dBase data set…”,
name the data “dataset” on the pop-up window and then browse to the ‘xlsx’ file that has the
regression dataset.
# Load the columns of the table into variables
Convetional_density = Dataset$Convetional_density
gv_volume1 = Dataset$gv_volume1
# Do the regressions
Regression_volume1 <-lmodel2(Convetional_density~ gv_volume1, data=Dataset, "interval",
"interval",99)
# Print the regression results
Regression_ volume1
The following are part of the regression results:
> Regression_ volume1
Model II regression
R2 = 0.9998112
Parametric P-value (1-tailed) = 6.687474e-09
Regression results
Method
Intercept
Slope
Angle (degrees)
RMA
-0.3847041 0.01309576 0.7502888
47
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Appendix B. Regression results

Table 7 - The equations and the coefficients of determination of the regressions

Reconstructed
volume
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39

Greyscale - density calibration equation

CT density = 0.01148161* gv - 0.3321912
CT density = 0.007370822* gv - 0.3101589
CT density = 0.01330115* gv - 0.3809996
CT density = 0.01264336* gv - 0.2817903
CT density = 0.007753436* gv - 0.3802119
CT density = 0.01309576* gv - 0.3847041
CT density = 0.03721415* gv - 0.6603485
CT density = 0.01294966* gv - 0.3149188
CT density = 0.01318806* gv - 0.355699
CT density = 0.01156662* gv - 0.3905499
CT density = 0.01277104* gv - 0.3096305
CT density = 0.01365867* gv - 0.3173754
CT density = 0.007542727* gv - 0.3255008
CT density = 0.01166322* gv - 0.3129883
CT density = 0.01263453* gv - 0.361692
CT density = 0.01225891* gv - 0.4121855
CT density = 0.0123316* gv - 0.2845394
CT density = 0.01316043* gv - 0.3456086
CT density = 0.007525346* gv - 0.3234818
CT density = 0.01235991* gv - 0.351937
CT density = 0.01207482* gv - 0.3793724
CT density = 0.01412469* gv - 0.459653
CT density = 0.01308913* gv - 0.4052635
CT density = 0.01237483* gv - 0.3183946
CT density = 0.01157408* gv - 0.3069922
CT density = 0.01151418* gv - 0.5131545
CT density = 0.01319592* gv - 0.2893366
CT density = 0.0133217* gv - 0.3950061
CT density = 0.01373134* gv - 0.3482365
CT density = 0.01685997* gv - 0.5263209
CT density = 0.01274244* gv - 0.3349409
CT density = 0.01331264* gv - 0.3364057
CT density = 0.013784* gv - 0.3544914
CT density = 0.0127086* gv - 0.3740552
CT density = 0.01676673* gv - 0.5163949
CT density = 0.01364231* gv - 0.3469475
CT density = 0.01308079* gv - 0.3788067
CT density = 0.01328738* gv - 0.5540642
CT density = 0.01308768* gv - 0.361368
48

Coefficient of
determination (R2)
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
>99.9%
99.9%
99.9%
99.9%
99.9%
99.9%
99.9%
99.9%
99.9%
99.9%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
99.8%
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CT density = 0.01489911* gv - 0.5230056
CT density = 0.01433946* gv - 0.5391068
CT density = 0.01278225* gv - 0.3189747
CT density = 0.01316803* gv - 0.3365204
CT density = 0.01380651* gv - 0.3591638
CT density = 0.01251666* gv - 0.3698284
CT density = 0.012208* gv - 0.4742786
CT density = 0.01311183* gv - 0.3332879
CT density = 0.01205683* gv - 0.5837271
CT density = 0.01345658* gv - 0.320354
CT density = 0.008114646* gv - 0.4188082
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99.7%
99.7%
99.7%
99.7%
99.7%
99.6%
99.5%
99.5%
99.5%
99.3%
99.0%

